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ABSTRACT   
 
This report describes the implementation and usage of ‘SWANSURF’, a graphically-driven 
program for the modelling of waves and surf conditions in the littoral, in support of 
amphibious operations. The program is based on a coupling of the SWAN (Simulating Waves 
Nearshore) model developed by the Delft University of Technology and the SURF model (or 
the Navy Standard Surf Model) developed by the US Navy. The Graphical User Interface 
provides a platform that allows the user to easily enter inputs, run the coupled models, view 
the results and forecast the potential impacts of the conditions on amphibious and other 
littoral operations.  
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The SWANSURF Wave Model: Implementation and 
User Manual     

 
Executive Summary    

 
A capability to provide detailed, accurate forecasts of the wave and surf conditions 
prevailing in the littoral is an important factor in the success of amphibious landings 
and other shallow-water operations. In particular, knowledge of surf parameters 
allows commanders to make assessments concerning the choice of beach landing site, 
optimum landing time frame, and choice of craft so that casualties, both craft and 
personnel, are minimised. Not only can surf and wave models be used in an 
operational context, they can also play an important role from an engineering 
perspective. For instance, they can be used when designing new amphibious systems 
and vehicles. SWANSURF was written to provide the Royal Australian Navy (RAN) 
with a single, user-friendly, graphically-driven tool that has the capability to 
adequately model both the nearshore zone and the surf zone accurately, along with its 
potential impacts on amphibious operations, something that was not available at the 
time of writing. This report describes that tool, which is maintained as a DSTO research 
facility, and the core models and interface designs, which have also been implemented 
by Royal Australian Navy Directorate of Oceanography and Meteorology (DOM) as a 
component of an operational command decision aid. 
 
This document describes the development, implementation and usage of the 
SWANSURF program. The basis of SWANSURF is a coupling of two existing models, 
Simulating WAves Nearshore (SWAN) and the Navy Standard Surf Model (SURF), to 
produce a combined wind-wave and surf forecasting tool. Given appropriate inputs, 
the coupled model predicts the wave and surf conditions prevailing in a small area (up 
to 25 km in easterly and northerly extent) in detail, as a function of both geographical 
location and time. The two component models are linked together by interface code 
that converts the outputs of SWAN to the inputs of SURF and then invokes it 
automatically; this enables rapid and accurate forecasting of surf zone conditions on 
the basis of the conditions prevailing in the open ocean, in a manner that is transparent 
to the user. The SWANSURF program is driven by a graphical user interface, which 
simplifies the processes of setting up the required input files and displaying the 
resulting information in graphical formats that are easily interpreted.  
 
Sections of this report provide an overview of the coupled SWANSURF model; 
describing its theory, usage, application, and limitations. Considerable efforts have 
been made to reduce the complex inputs required by the component models to the few 
inputs that are most critical and that are likely to be available to the operator. In order 
to function, the model requires accurate measurements or forecasts of winds, tides, 
bathymetry and topography. Availability of these inputs is the major operational 
limitation of the model. 
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1. Introduction 

Wave and surf conditions in the nearshore zone play an important role in many naval 
operations and particularly so in amphibious operations; they affect the ability of an 
amphibious task group to load and transfer materiel and personnel at sea, the ability of 
ships and landing craft to transit to shore, and the ability of vessels of all kinds to load 
and unload while on-shore. The capacity to predict the conditions that are likely to 
prevail at specified locations and times is important to operational decision makers. 
Knowledge of surf parameters allows commanders to make assessments concerning 
the choice of beach landing site, optimum landing time frame, and choice of craft so 
that casualties, both craft and personnel, are minimised. Wave and surf models also 
play an important role from an engineering perspective. For instance, they can be used 
when designing new amphibious systems and vehicles. To achieve these objectives, 
accurate, reliable and rapidly-executing models are required that predict a wide range 
of wave parameters from the surf zone to a considerable distance offshore. 
 
This document describes a Graphical User Interface program, ‘SWANSURF’, which 
provides a user-friendly interface to a coupling of two existing models, Simulating 
WAves Nearshore (SWAN) and the Navy Standard Surf Model (SURF), to produce a 
combined wind-wave and surf forecasting tool. SWAN models the two-dimensional 
wind-wave field, and SURF propagates an offshore wave spectrum onto the beach to 
produce forecasts of surf conditions. The coupled model (SWANSURF) predicts the 
wave and surf conditions prevalent in a particular area, given wind, tide, bathymetric 
and topographic data. SWANSURF was written to provide the Royal Australian Navy 
(RAN) with a single, unified tool that has the capability to adequately model both the 
nearshore zone and the surf zone accurately, along with its potential impacts on 
amphibious operations, something that was not available at the time of writing. 
Although primarily intended as a developmental package, the present model could be 
used operationally as a standalone tool. The core routines and the design of the 
interface have been included in GIS-based command decision aids that are now fielded 
operationally by the Directorate of Oceanography and Meteorology [Woodham 2005]. 
 
The SWANSURF model is driven by a graphical user interface which makes the model 
easy to use, both in terms of setting up the required input files and in terms of 
displaying the resulting information in graphical formats that are easily interpreted 
and understood. The underlying models are linked in such a way that their operation 
is automated – there is no requirement for the user to manually construct inputs for 
either model, and SURF is invoked automatically when SWAN terminates. 
 
The purpose of this report is to provide an overview of the SWANSURF model; 
describing its theory, usage, application, and limitations. Section 2 of this report 
presents a brief description of the two stand-alone models SWAN and SURF and the 
reasons why these particular models were selected. Section 3 provides an overview 
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explanation of the SWANSURF model – the assumptions made and a user manual. 
Section 4 offers a discussion of potential future enhancements to the model. 
 
 

2. Wave Forecasting Models 

Brief descriptions of the two models SWAN and SURF follow. Refer to the individual 
manuals for each of these models for more detailed information ([Booij et al. 2004] for 
SWAN, and [Osieki et al. 2002a, 2002b] for SURF). 
 
 
2.1 Simulating WAves Nearshore (SWAN) [Version 40.41] 

Simulating WAves Nearshore, or SWAN, is a numerical wave model developed by the 
Delft University of Technology, Netherlands. Given wind and seabed conditions in the 
study area and the wave spectra and currents at the edges of the study area, it 
computes various wave parameters, particularly for small-scale coastal areas with 
shallow waters.  
 
A number of wave propagation processes are encompassed by SWAN, such as 
refraction and shoaling due to spatial variations in bottom conditions and currents, and 
blocking and reflections due to opposing currents and obstacles. Generation and 
dissipation processes are also considered, such as local wave generation by wind, 
dissipation by bottom friction, depth-induced wave breaking, whitecapping, and 
wave-wave interactions. ([Booij et al. 2004] p3) 
 
SWAN can be run in either stationary mode or non-stationary (dynamic) mode. In 
stationary mode, the model runs with fixed boundary conditions, terminating when it 
has evolved to a steady or ‘fully developed’ state. Non-stationary mode allows the 
boundary conditions to change with time – it is essentially a succession of stationary 
runs, where the output wave conditions of each run provide the input wave conditions 
for the next. Wind and tidal height variations are supplied by the user. Stationary runs 
are valid for waves whose transit time through a region is small when compared to the 
timescale of change in the conditions (for example, winds or tides) of the area through 
which they pass ([Booij et al. 2004] p3). 
 
The primary use of SWAN is as a coastal wave prediction tool and the operating 
instructions of earlier versions of SWAN stipulated that it should not be used at scales 
greater than approximately 25 kilometres or to analyse areas where, in a distance of a 
few wavelengths, changes in wave height are large [Holthuijsen et al. 2000]. This 
restriction has been removed in the latest version of SWAN, primarily to allow the user 
to nest SWAN in deep water oceanic models such as WAM or Wavewatch III. SWAN is 
not as effective as WAM or Wavewatch III for oceanic scales. Previous SWAN models 
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used Cartesian coordinates (Eastings and Northings) and could not be nested in WAM 
or Wavewatch III which use spherical coordinates.  
 
Although SWAN produces many output variables, the user can choose which of those 
outputs are to be displayed in the SWAN output reports. Output can be produced for 
an arbitrary point, line, curve, or area within the modelled area.  
 
To obtain more detail about the SWAN model, including its theory, assumptions, 
capabilities, limitations, and options, refer to the SWAN manual [Booij et al. 2004] 
 
 
2.2 Navy Standard Surf Model (SURF) [Version 3.1] 

The Navy Standard Surf Model, or SURF, was developed for the US Navy in the late 
1980s. It arose from the operational requirements outlined in the US Joint Surf Manual 
[COMNAVSURFPAC/COMNAVSURFLANT 1987] and has been used continually 
since then to satisfy those requirements. 
 
The primary focus of the model is to provide local surf and longshore current forecasts 
to enable operators of amphibious watercraft to make decisions concerning the 
viability of performing certain military operations given the prevalent environmental 
conditions ([Osieki et al. 2002a] p5). It is based on the work of Thornton and Guza 
[1983, 1986], who were responsible for developing numerous models for random wave 
processes; in particular, breaking wave probability distribution hypotheses. 
 
Unlike SWAN, which has the ability to perform forecasts on a two-dimensional region, 
SURF carries out its computations on a one-dimensional line perpendicular to the 
beach. This is appropriate for models that predict wave breaking [Earle 1999]. The 
reason for this is that wave breaking is determined by local depth. Specifically, when 
waves enter waters where the depth is less than half their wavelength, their 
wavelengths will decrease while their wave heights will increase. When the wave 
height to water depth ratio becomes greater than 0.78, the wave will break. 
 
Basically, the SURF program numerically solves the steady-state energy balance 
equation. This equation describes the dissipation of energy due to wave breaking, 
bottom friction, turbulence and wave-current interaction. The model calculates wave 
energy, and, in turn, wave heights stepwise at a sequence of distances starting from an 
offshore point and moving in towards the beach.  
 
Breaker type percentages are calculated through the surf zone based on a probability 
distribution of breaking waves. This distribution is derived from the effect of bottom 
slope as well as the breaker height and period. 
 
Being a one-dimensional model, SURF incorporates a number of approximations. 
Namely, SURF assumes that linear wave theory is applicable, that bottom contours are 
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straight and parallel, that currents do not vary with depth, that wave heights are 
Rayleigh-distributed, and that directional wave spectra are narrow-banded in 
frequency and direction ([Osieki et al. 2002a] p. 5). 
 
The information required to run the SURF model is a depth profile, a directional wave 
spectrum at the offshore point, and refraction and shoaling coefficients. These may be 
either externally provided by the user or internally generated by SURF.  
 
The SURF model outputs a number of forecast surf parameters for a user-specified 
approach to the beach. Among SURF’s outputs are the maximum and significant 
breaker height, percentage of breaking waves, wavelength, and the longshore littoral 
current. SURF also provides an estimated percentage of breaker wave types - namely, 
spilling, plunging, and surging waves - that are present for the chosen beach approach 
under given conditions. Furthermore, SURF calculates the Modified Surf Index (MSI). 
The MSI is a single number that summarises the surf zone conditions – the higher the 
MSI, the rougher the environment [COMNAVSURFPAC/COMNAVSURFLANT 1987]. 
 
Refer to [Osieki et al. 2002a] and [Osieki et al. 2002b] to obtain greater detail on the 
theory behind the SURF model, as well as its available options and examples.  
 
 
2.3 Reasons for Using and Coupling the Two Models SWAN and 
SURF 

A DSTO study of models for wave prediction [Andrew, 1999] found that no single 
model predicted both nearshore wave conditions and surf conditions adequately. For 
this reason, to effectively model surf zone dynamics, including the approach towards 
the beach, DSTO elected to combine a nearshore wave model and a surf zone breaking 
wave model to form one forecasting tool. This section explains why SWAN and SURF 
were the chosen models and, in turn, why these models were coupled into a single 
application rather than being used as two standalone programs. 
 
2.3.1 Reasons for Choosing the SWAN and SURF Models 

In the DSTO study of nearshore wave models (including the ‘REF/DIF_S’, ‘Wave’, 
‘REFRAC’, and ‘Boussinesq’ programs), SWAN was identified as the best model for 
simulating growing waves in nearshore areas [Andrew, 1999]. In situations where the 
waves were no longer growing, REF/DIF_S was considered more suitable, since it also 
modelled diffraction. It should be noted, however, that when the Andrew [1999] study 
was written, the SWAN version at the time (version 40.01) did not model diffraction. 
The current version of SWAN simulates diffraction effects. The SWAN code and 
manuals are freely downloadable from the Delft University of Technology website 
(http://fluidmechanics.tudelft.nl/swan/default.htm).  
 



 
DSTO-GD-0475 

 
5 

The SURF model was the chosen surf modelling program because it has been used 
extensively in the US since 1988 to assist with the planning of amphibious operations 
and has been embedded in a number of navy operational systems; for instance, the 
United States’ Tactical Environment Support System (TESS).  
 
While SWAN is a well-tested and accurate model, it has its limitations; particularly in 
harbours and areas where obstacles are present. The SWAN model was developed for 
wave modelling of inshore areas. It can model some characteristics of the surf zone but 
was not developed for that purpose. SURF, in contrast, was specifically developed to 
model surf zone conditions along a line perpendicular to the beach. SURF does not 
model the entire area offshore. Therefore, the SURF model has been embedded into the 
SWAN model as a coupled application to enable the user to gain a better 
understanding of the complete operational area. 
 
As previously mentioned, SURF derives from the work of Thornton and Guza [1983, 
1986], who modelled energy dissipation based on a Rayleigh distribution of wave 
heights. Although SURF is a one-dimensional model, it is effective in modelling the 
surf zone and wave breaking. The reason for this is that wave breaking is 
predominantly determined by local depth.  
 
SURF outputs a number of parameters that are pertinent to an analysis of the surf zone 
which are not calculated by SWAN. These SURF parameters are particularly important 
for amphibious operations. In fact, the SURF model was specifically designed to meet 
the operational requirements as expounded in the US Joint Surf Manual 
[COMNAVSURFPAC/COMNAVSURFLANT 1987]. Among these parameters is the 
Modified Surf Index (MSI). This is a single dimensionless number summarising the 
surf conditions in a particular location, taking into account all the environmental 
factors. The MSI is calculated based on the highest significant breaker height occurring 
in the surf zone and the maximum longshore current, along with the breaker type, 
breaker angle, and the wave period. (For further discussion of the MSI’s importance in 
military operations, refer to section 3.4.4.) The surf zone width and number of surf lines 
(that is, waves in the surf zone) are also determined. The surf zone width is the 
distance from the water’s edge to the furthest point out to sea where waves start to 
break (Figure 1). Large surf zone widths can have a negative effect on amphibious 
operations. The number of surf lines is given by the surf zone width divided by the 
dominant wavelength.  
 
SURF also calculates the percentage of different breaker types; that is, the proportion 
that are spilling, plunging, or surging. Knowing which breaker types occur on the 
beach under investigation is extremely important. For instance, spilling waves are 
predominantly characteristic of gently sloping beaches and are the preferred breaker 
wave type for the successful implementation of amphibious operations in terms of 
minimum casualties (both personnel and landing craft). In contrast, plunging breakers 
usually emerge on steep beach gradients and result in a forceful and rapid release of 
energy making amphibious landings difficult and dangerous (although still possible) 
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with potential risk to craft. Surging breakers predominate on beaches that are 
extremely steep, almost vertical. Essentially, these breakers hit the beach as a wall of 
water with wave crest and base arriving at the beach at the same time. The passage of 
such a breaker is equivalent to a rapid rise and fall in water level. As a consequence, 
maintaining landing craft in position (for activities such as unloading) becomes very 
difficult or more usually, impossible. 
 
Not only is the type of breaking wave important, but so too are the breaker height and 
the angle of the breakers with respect to the shoreline. The SURF model outputs both 
the maximum and significant1 breaker height. If the breaker height is high enough, the 
wave may break on the stern of the landing craft as it lands or withdraws from the 
beach. Therefore, the craft may become filled with large amounts of water and 
swamped. The breaker angle is important because it may lead to the craft having 
difficulty remaining on course and, as a result, it may land at the wrong site. 
Alternatively, the craft may be propelled parallel to the beach, thereby becoming 
grounded. The SURF program also tells the operator the direction of the breaker 
measured relative to a perpendicular approach towards the beach (left or right flank) 
as viewed by an observer at sea. Figure 1 shows waves heading towards the left flank 
as seen by an observer on the landing craft. Also shown on the diagram is how the 
breaker angle is measured. If the waves were travelling parallel to the shore, then the 
breaker angle would be zero degrees.  
 
All the surf parameters considered above can have a critical influence on the success of 
an amphibious operation in terms of both personnel and craft safety, as well as 
optimum deployment of the available landing craft. A more extensive discussion of 
surf parameters can be found in [COMNAVSURFPAC/COMNAVSURFLANT 1987].  
 
By performing different SURF runs that consider approaches to a number of alternative 
landing sites, the SURF model enables the operator to decide which beach to land on, 
what the best approach to that beach is, and which craft to use. 
 

                                                      
1 The significant breaker height is the mean height of the highest third of the distribution of 
heights 
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Figure 1:  Selected surf zone parameters. 

 
 
2.3.2 Reasons for Coupling the Two Models into One Forecasting Tool 

Although the SURF model provides the information needed to ascertain the feasibility 
of amphibious operations as well as general information regarding the surf zone, it was 
nested as part of a SWAN run, rather than being used as a standalone model, for a 
number of reasons.  
 
Firstly, the SWAN model outputs a wave spectrum file. Data from this spectrum file 
can be used as input to the SURF model. Although SURF has the option of generating a 
wave spectrum internally from two input wave parameters (for the dominant sea and 
the dominant swell), the SWAN model allows the user to combine multiple wave 
inputs and this gives a more accurate picture of the conditions prevalent in the area 
under investigation. Directional wave spectra, which depict the distribution of wave 
energy in terms of frequency and direction, are the primary input of the SURF model. 
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Therefore, providing a spectrum that contains inputs from more than two waves (and 
from at least one wind wave and one swell wave) should produce more accurate 
results. 
 
Secondly, SWAN allows for tidal effects. The model allows the user to input both time- 
and spatially-varying tides. Therefore, the spectral outputs produced by SWAN and 
subsequently used as inputs to SURF implicitly include the effects of tides. This is 
important, because tides influence the breaker height, and they can also have a 
significant effect on the nature and width of the surf zone.  
 
Thirdly, coupling the models makes the operation of the programs easier for the user. 
Rather than running SWAN and manually extracting the relevant data and formatting 
it into the appropriate SURF input file format, it is much easier and more convenient to 
have an additional, DSTO-supplied module to do this automatically. In particular, 
SWAN can produce wave forecasts at predetermined time steps. Direct coupling 
allows time series of both inshore wave fields and surf parameters to be routinely 
output. By nesting SURF in SWAN, the SURF model can be automatically called by the 
SWAN model at each time step and all the required input files can be set up 
automatically. Run by itself, the SURF model would require the user to set up all the 
input files at each time step manually, because the SURF model cannot be run 
continuously for a number of time steps. This becomes very tedious.  
 
The fourth reason to nest SURF into SWAN to obtain one forecasting tool is that by 
coupling the two models, more realistic simulations of amphibious operations and 
strategies can be made over extended areas. Although SURF provides a number of 
useful outputs, it is a one-dimensional model and only produces data along a 
particular line approaching the beach. Since SWAN is a two-dimensional model, it 
provides forecasts over a much larger region, extending from the coast into deeper 
water, thereby giving the operator a visualisation of the total area of operation, rather 
than just a limited portion of it. Also, SWAN calculates a variety of different wave 
parameters (see section 2.1) that are not computed by SURF.  
 
 
 

3. The SWANSURF Forecasting Model 

3.1 Description of the SWANSURF Model 

As previously mentioned, the forecasting model is a single application that links the 
SWAN and SURF models. The main task in formulating the coupled model was to 
convert the SWAN output to the input format used by SURF. Very few modifications 
were made to the original models. Rather, additional Fortran subroutines were created 
which converted the relevant SWAN output into SURF input files.  
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To run the SURF model, an input file is required with the parameters shown in Figure 
2 (refer to the SURF manual for more details [Osieki et al. 2002a]). 
 
 

Line Description Units Range 
1 Input File Name - - 
2 Date and Time (YYYYMMDDHH) - - 
3 Landing Zone Name - - 
4 Input Depth Profile File Name - - 
5 Input Wave Spectrum File Name - - 
6 Input Wave Refraction File Name - - 
7 Compass Heading Toward Beach Degrees 0 - 359 
8 Slope / Sediment Type - 1 - 10 
9 Starting Depth Feet > 0 

10 Offshore Wave Spectrum Depth Feet > 0 
11 Sea Wave Height 

Sea Wave Period 
Sea Wave Direction 
Swell Wave Height 
Swell Wave Period 
Swell Wave Direction 

Feet 
Seconds 
Degrees 
Feet 
Seconds 
Degrees 

> 0 
1 – 30 
1 – 359 
> 0 
1 – 30 
1 – 359 

12 Wind Speed 
Wind Direction 
Tide Elevation 

Knots 
Degrees 
Feet 

> 0 
0 – 359 
+ or - 

13 Output Data Grid Spacing Feet > 0 and < 10 

Figure 2: The contents of the SURF Input File (*.in) 

 
The input file name is taken to be the project name with an ‘.in’ file extension. The date 
and time field was extended to include minutes (mm) and seconds (SS); specifically, 
YYYYMMDD.HHmmSS. The landing zone name was arbitrarily chosen to be ‘SURF 
Zone’.  
 
SURF allows the user to input either a depth profile along a perpendicular approach to 
the beach (the ‘surf transect’) or a beach slope-indicating sediment type (for example, 
boulders, coarse sand). SWANSURF uses depth data from a combined bathymetry / 
topography file to produce the depth profile file required by SURF. Consequently, the 
slope or sediment type line in the input file (line 8) is left blank, while line 4 contains 
the name of the depth file. The input depth profile file name is *.dep where * is the 
project name.  
 
Similarly, the user can input either a spectrum file containing the required wave data 
or single numbers for the sea wave height, period and direction and the swell height, 
period and direction. The coupled model selects the former. Hence, line 11 of the input 
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file is left blank. The input wave spectrum file name is written in line 5. It is just the 
project name with the extension ‘.spc’.  
 
The starting depth is input as zero. This means that SURF does not use the self-start 
option. Hence, calculations are performed starting at the point stored in the depth 
profile file that is farthest offshore. As a result, a potential error caused by excess 
energy dissipation associated with the wave breaking probability (Rayleigh) 
distribution used by the model is avoided, as calculations are started well outside the 
surf zone [Earle 1999]. (Note that if the self start option were to be used, then the 
offshore wave spectrum is shoaled and refracted to the starting depth specified [Osieki 
et al. 2002a], resulting in reductions in both model run time and quantity of output 
data. This option was not used since the SURF model run time is not excessive.) The 
offshore wave spectrum is located on the surf transect at the most distant point from 
the beach. The SWANSURF model ignores all refraction effects in the surf zone so line 
6 contains the word ‘none’.  
 
Other parameters required as input to the SURF model include the compass heading of 
the surf transect towards the beach, wind data and tide data. The compass heading is 
calculated in a subroutine using the formula:  
 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −
= −

)1cos(*)sin(
)cos(*)1sin()2sin(cos 1

latitudedist
distlatitudelatitudedingCompassHea  

 
where dist is the great circle distance (measured in radians) between the two points. As 
was the case for the spectrum file, the wind speed and direction are calculated from 
data at the point that is furthest offshore. All other directions (for example, wind 
direction and wave direction) are measured relative to True North. 
 
All SURF input data is taken from the SWAN one-dimensional output table 
‘*_SWAN1D.tab’, where ‘*’ is the project name. It should be noted that the depth in this 
table is depth of the seabed relative to the bathymetric height datum, plus the level of 
the tide above that datum. Therefore, to prevent the double addition of tides, the tide 
elevation is set to zero in the SURF input file. Tide is included as part of the bottom 
profile rather than as a separate variable which is added on by the SURF program, 
because the SWAN program allows for spatially-varying tide data, whereas the SURF 
program assumes the tide level is constant at each point along the surf transect. The 
extra information leads to more accurate results.  
 
The final piece of information required to form the SURF input file is the output data 
grid spacing. This is automatically calculated by the coupled model and is based on the 
length of the surf transect. The grid spacing cannot exceed 10 feet (approximately 3 
metres).  
 
Note that the SURF model uses feet and knots in the input file and also to perform all 
its calculations whereas SWAN uses metres and metres per second. The subroutines 
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convert the SWAN outputs to the appropriate units as required by the SURF program. 
SURF output is then converted back to metres and metres per second. 
 
A depth profile file is also created from the SWAN data, as shown in Figure 3. The 
format for the depth profile file as described in the SURF manual states that distances 
offshore are to be positive while distances onshore are to be negative. Since the SURF 
code itself does not impose this limitation, SWANSURF takes all distances to be 
positive measured from the first available point onshore for coding simplicity. Also, it 
is not important whether depths are entered in the depth profile from onshore to 
offshore or vice versa, since SURF is programmed to reorder the depths where 
necessary.  
 

Line Description   
1 Depth Profile 

File Name 
  

2 Distance Units 
1 – feet 
2 – metres 
3 - yards 

  

3 Depth Units 
1 – feet 
2 – metres 
3 – yards 

  

4 to end of file Index Distance 
 
 

Depth 
[Depths (+) 
Elevations (-)] 

Figure 3: SURF Depth Profile File (*.dep) 

 
SURF 3.1 allows the user to enter a maximum of 500 depth profile data points. Since 
the maximum output grid spacing is approximately 3 metres, the maximum length of 
the line along which SURF performs its calculations is only 1524 metres. In 
SWANSURF this length is extended to 3000 metres, to enable the operator to gain a 
better understanding of the prevailing conditions along the approach towards the 
landing site from greater distances offshore. Therefore, the surf transect can now 
contain more than 500 data points; however, the maximum output grid spacing has 
been preserved.  
  
SWANSURF uses a file to input the wave parameters required to run the SURF 
program. The data is taken from the spectrum file produced as SWAN output and has 
the form shown in Figure 4 (adapted from [Osieki et al. 2002a]). This SURF spectrum 
file, *.spc, is created from the SWAN output spectrum file, *_SWANSpec.out (where ‘*’ 
is the project name).  
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Line Description Units Range 
1 Spectrum File Name - - 
2 Number of Angles - 1 - 180 
3 Number of Directions - > 0 
4 Number of Frequencies - 1 - 50 
5 Initial Direction Degrees 1 - 359 
6 Width of Direction Bin Degrees 2 - 180 
7 Direction of Waves 

1 = Direction waves are coming from 
2 = Direction waves are going to 

  

Directional Wave Spectrum 
(This section is repeated for each Frequency Bin) 

 Bin Number Integer 1 - 50 
 Lower Limit of Frequency Bin 

Centre of Frequency Bin 
Upper Limit of Frequency Bin 

Hertz 
Hertz 
Hertz 

>= 0 
>= 0 
>= 0 

Metres2  Directional Wave Spectrum 
Hz * rads 

>= 0 

Figure 4: SURF Wave Spectrum File (*.spc) 

 
Not only were Fortran subroutines created to convert the SWAN output data to SURF 
input data, but the SURF program itself was set up as a subroutine of the SWAN 
program. The coupled model runs the SWAN model at fixed time steps specified by 
the user. At the completion of each time step, the output produced by SWAN is 
converted to SURF input and the SURF subroutine is invoked, as shown in Figure 5.  
 
Due to the complicated nature of the SWAN input file, producing it is a laborious task 
and requires the user to have an understanding of wave modelling. Therefore, to make 
the coupled SWAN and SURF model useful in the field, it was necessary to make the 
coupled model user friendly and easy to understand. A previous Graphical User 
Interface (GUI) was generated by Hamilton [2001] to simplify the inputs to the SWAN 
model. Those simplifications have also been implemented in the GUI described herein. 
Consequently, to run the coupled model, the user requires minimal knowledge of 
nearshore wave processes. Inputs to the SURF model are automatically obtained from 
the outputs generated by SWAN. The inputs required from the user are discussed in 
the following section. 
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Figure 5: The SWANSURF calling sequence. 

 
 
3.2 Input Requirements: Model Assumptions and User Options 

SWANSURF requires a number of inputs from the user. Most of these are inputs to the 
SWAN model. A GUI was set up in Visual Basic to simplify the creation of this input 
file [Hamilton 2001]. This GUI has now been substantially upgraded and modified to 
include the SURF model, an output viewer, and displays of Royal Australian Navy 
hydrographic charts. The map display facilitates easy selection of the area of interest 
and the input of a line extending from the surf zone to a landing point on the coast 
along which SURF output is required.  
 
To set up a SWAN input file, the user must select ‘Create SWAN Input File’ from the 
‘Options’ menu or alternatively, click the  icon. The multi-page form that 
subsequently appears allows all inputs required to run the SWANSURF model to be 
entered. Considerable care has been taken to trap user errors in the data-entering phase 
of the project. When invalid data has been entered into any of the input fields of the 
GUI, the font for that input turns bold and red. Correct data is displayed in black text. 
Pointing the mouse at a text box without clicking displays the valid range of values for 
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that data element. Furthermore, when all required data has been keyed into a tab 
correctly, its corresponding ‘light’ in the ‘Input Checklist’ frame turns green; otherwise 
the ‘light’ is red.  
 
Firstly, a project name and location are required. To do this, either type the details 
directly into the appropriate text boxes on the form, or press the ‘Choose Project Name 
and Location’ button. Pressing this button will bring up an Explorer™ style file 
manager. Simply choose a directory and folder where the project files will be stored or 
alternatively create a new directory and/or folder. Type the project name in the ‘File 
name’ text box and then click ‘Save’. Due to the number of output files produced by the 
coupled model, it is recommended that a new folder be created for each project.  
 
The SWAN model requires the bounding coordinates of the area under investigation. 
By clicking on the ‘Area Coordinates’ tab (Figure 6), the user can define a rectangular 
box within which SWANSURF performs its calculations. The SWANSURF model uses 
spherical coordinates (geographical latitude and longitude coordinates in degrees) as 
opposed to Cartesian coordinates (grid locations in metres relative to user defined x- 
and y-axes). The reason for this is that Cartesian coordinates are only valid for small 
areas, whereas spherical coordinates can be used for both large and small scales. 
Spherical coordinates are also easier to work with when dealing with geographical 
data. 
 
Required inputs for the ‘Area Coordinates’ tab are the longitude and latitude 
coordinates (in degrees) of the bottom left and top right corners. The grid coordinates 
can either be entered manually (by typing into the text boxes) or graphically, by 
drawing a box over the map (that is, clicking the  icon and dragging the mouse). The 
usual ‘zoom in’ , ‘zoom out’ , and ‘pan’  features are available to the map. The 
SWANSURF GUI stipulates that this box should be at least 50 metres by 50 metres and 
at most 25 kilometres by 25 kilometres. Although the current version of SWAN (40.41) 
[Booij 2004] allows larger areas to be modelled, the recommendation of previous 
versions of SWAN (40.11) [Holthuijsen 2000] that the grid should not exceed this size is 
maintained. The reason for this is that SWAN is not as effective when larger areas are 
used. The dimensions of the area selected by the user are displayed in the Visual Basic 
interface (Figure 7). The computational area must extend sufficiently far onto the land 
to account for tides and to enable an approach line to be drawn from offshore to the 
beach.  
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Figure 6: The ‘Area Coordinates’ tab from the SWANSURF GUI. This is where the user defines 

the SWAN computational area. 

 
Since the global map included in the GUI is only a low-resolution vector outline of the 
coast, the GUI enables the user to load map images (for instance, SeaFarer Geotiffs) to 
obtain a more accurate representation of the area under investigation (Figure 8). To 
load a map image, choose Map Tools > Add Map Layer or click on the  icon and 
select the required file. Some SeaFarer GeoTiffs are already included in the software 
package. These are indicated by pre-drawn rectangles on the map (Figure 8). To load 
one of these, simply click on Map Tools > Click a SeaFarer Tile to Load Chart Image 
(or alternatively, click the  icon) and then click on the predefined square for the area 
required.  
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Figure 7: Rectangle showing the chosen SWAN computational area. 

 
 
 

  
Figure 8: The ‘Area Coordinates’ tab depicting the pre-drawn rectangle of the preloaded 

SeaFarer GeoTiff (left). Clicking the appropriate icon and then clicking the rectangle 
loads the chart (right). 
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From the computational area chosen, the program sets up a combined bathymetry and 
topography profile, BathyTopo.bot. (For the format of this file refer to Appendix A.1 
Depth Data File (BathyTopo.bot).) The depth data file is created from a gridded 
bathymetry data file; that is, bathymetry and topography is read from a file that is 
organised as a grid of latitude and longitude points. Two default bottom data files are 
included as part of the SWANSURF package: 
 
• For Australian geographical areas (102 to 172 degrees East longitude and -8 to -52 

degrees South latitude), a 36 second (approximately 1 kilometre) digital terrain 
model (DTM) from Geoscience Australia (bathytopo.asc). 

• For areas outside Australia, a two-minute DTM (etopo2.dat) from the National 
Geophysical Data Centre (NGDC). 

 
The quality of the model outputs depends on the resolution and accuracy of the input 
bathymetry data contained in the BathyTopo.bot file. Since both the included files are 
fairly coarse, provisions have been made to allow the user to obtain data from other 
sources if these files contain both bathymetry and topography data and the data 
contained in them completely covers the area of interest. Since wave action in the surf 
zone is also influenced by the beach slope, it is crucial that the bottom data file contains 
both bathymetry and topography data; otherwise the SURF component of the coupled 
model will not function correctly.  
 
It is also important that the bathymetric/topographic data selected covers an area 
larger than the chosen wave modelling area, because if there is no data available 
outside the computational perimeter, SWAN assumes that the data just outside the 
boundary is equal to that on the boundary, leading to unreliable computations. 
Therefore, SWANSURF requires the user’s bathymetric/topographic data to cover not 
only the area of interest, but also a two mesh wide margin around that area. If the data 
contained in the user’s data file does not sufficiently cover the area under investigation, 
then the program will resort to using the default data. If this happens, the user will be 
alerted by a pop-up message. In general, when defining the area of interest, there is no 
need for the user to add a margin around their chosen area in order to counteract any 
edge effects; the GUI will automatically set up a depth data file that meets this 
requirement. 
 
To choose the relevant bathymetry/topography data file, the user must select it from 
the drop-down file list. If it does not appear in the available file list, then it will need to 
be added. This can be done by clicking on the ‘Add File to List’ button. This will bring 
up a data entry screen (Figure 9) where the required file details are entered. Note that 
the ‘Bathymetry File Details’ screen is where general details of the user’s bathymetry 
and topography data file are entered. It is not where specific details of the desired 
computational area are input. 
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Figure 9: The ‘Bathymetry File Details’ data entry screen. 

 
In order to add a file to the list, the user must firstly enter the structure of the data file. 
The available options are shown in the drop-down list. The data in the file must be 
stored as a grid, which can be read either across the rows or down the columns, 
starting at either the upper left corner or the lower left corner. The number of header 
lines contained in the file must be entered. Information is also required regarding the 
bathymetry data; namely, whether depths are measured as positive values or negative 
values, and the unit of measurement. The full extent of the bottom data covered by the 
file (as opposed to the extent of the area of interest) must be specified and this is done 
in a number of ways: 
 
• Entering the latitude and longitude coordinates of two opposing corners; either 

upper left and lower right, or lower left and upper right. 
• Entering the latitude and longitude coordinates for one corner and the number of 

grid points in both the x- and y-directions. 
• Entering the latitude and longitude coordinates for one corner and the number of 

meshes in both the x- and y-directions. 
 
The number of meshes is one less than the number of grid points. The distance 
between the grid points, which is equal to the size of the meshes, must also be defined. 
The latitude and longitude coordinates and number of grid points or meshes refer to 
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the full range of data covered by the user’s bottom data file as opposed to the latitude 
and longitude coordinates of the computational area chosen. 
 
Once all the bathymetry / topography data file details have been entered, click ‘OK’. 
The bottom file is added to the available file list and all details in the file are stored in a 
file *H.hdr where ‘*’ is the user’s data file name. This means that the user’s bottom data 
file can be used in future SWANSURF sessions without the user having to re-enter the 
appropriate file details. Files can be deleted from the file list by clicking on the ‘Delete 
File from List’ button in the ‘Area Coordinates’ tab. Once files are deleted from the list, 
the *H.hdr file is also deleted. Hence, if the user wants to use the deleted file at some 
later stage, the file will need to be re-added to the list and this will involve re-entering 
all the file details.  
 
The ‘Wave Parameters’ tab contains the options for entering an initial wave field for 
SWAN. The options are: a single initial significant wave height (between 0 and 10 
metres), period (between 0 and 30 seconds), and direction (degrees); multiple initial 
wave heights, periods, and directions; or wave data from a file (Figure 10).  
 

  
Figure 10 The ‘Wave Parameters’ input tab. Data can be entered as either a constant value for a 

single wave (left), a constant value for multiple waves (right), or from a file. 

 
When the multiple wave option is used, the GUI sets up a wave spectrum file 
(WaveSpecFile.dat) as required by SWAN (see Appendix A.3 Wave Spectrum File 
(WaveSpecFile.dat)). The wave spectrum encompasses all waves (both sea and swell) 
impacting on the area of investigation. Since the wave data must be input at each 
boundary, the spectrum file is copied four times (namely, WaveSpecFileN.dat, 
WaveSpecFileS.dat, WaveSpecFileE.dat, and WaveSpecFileW.dat) to define the north, 
south, east, and west boundaries of the area chosen.  
 
Wave data from a file can also be used. This wave data must be in the form of a wave 
spectrum, as described in Appendix A.3. Wave Spectrum File (WaveSpecFile.dat). 
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SWAN supports the input of wave data from a WAM output file. Support for this 
option is yet to be implemented in SWANSURF. 
 
The Nautical convention is used to define the wave direction. This means that the wave 
direction is the direction from which waves are approaching, with degrees being 
measured clockwise with respect to zero at geographical North (Figure 11). Therefore, 
for waves coming from the East, the wave direction is 90 degrees. Waves coming from 
the South have a direction of 180 degrees and so on. 
 
 

 
 

Figure 11: Nautical convention for defining wave and wind direction. 

 
By clicking on the ‘Wind’ tab, the user can enter the wind data by choosing one of three 
options (Figure 12). Namely, constant speed (between 0 and 100 metres/second) and 
direction (between 0 and 359 degrees); time series wind data for a maximum of twelve 
time steps; or gridded wind data from a file (see Appendix A.2 Wind (WindSeries.dat) 
and Tide (TideSeries.dat) Files for the required format). Although the wind data will 
vary for each time step when the time series option for wind is used, it will be spatially 
constant. Spatially variable wind data for each time step can be input by setting up a 
wind data file in the required SWAN wind file format. As was the case with waves, 
SWAN uses the Nautical convention to define wind direction. 
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Figure 12: The ‘Wind’ input tab. Data can be entered as either constant values (left), a time 

series (right), or from a file. 

 
Similarly, the ‘Tides’ tab allows the user to enter the tidal height data. Water level is 
measured positive above sea level relative to the same datum as used by the 
bathymetry data, and negative downwards. Tidal data can be input as either a constant 
(between –25 and 25 metres), a time series (with a maximum of twelve time steps), or 
from a file (Figure 13). Once again, if a time series is chosen, the tide data will be 
spatially constant for each time step. Spatially variable tide data for each time step can 
be input by setting up a tide data file in the required SWAN tide file format. For the 
format of the tide file refer to Appendix A.2 Wind (WindSeries.dat) and Tide 
(TideSeries.dat) Files. 
 
If a time series is entered for both wind and tide data, the time interval, number of time 
series points, and start date and time for the two time series do not have to be the same. 
For instance, the user can set up a wind series having twelve data points starting on the 
1st June 2005 at 23:00:00 with computations carried out at 40 minute intervals, while the 
tide series can begin on the 2nd June 2005 at 04:00:00 with only three data points at 
hourly intervals. If both a wind series and a tide series are entered, then SWAN will 
output data based on the wind time series.  
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Figure 13: The ‘Tides’ input tab. Data may be entered as either a constant value (left), a tide 

series (right), or from a file. 

 
 
It is recommended that the time step used to run the SWAN model should be small 
enough so that changes in the wave field and other parameters are well resolved [Booij 
2004].  
 
SWAN also gives the user the option of producing output along a predefined section 
within the area of computation. This predefined section may be a two-dimensional 
region, a curve or line, or even a point. Since SURF is a one-dimensional model and 
requires data along a line as input, the GUI was extended to allow the user to enter a 
line that lies in the confines of the user-defined SWAN computational grid (Figure 14). 
The SWAN model is able to provide outputs along this line such as the depth, wave, 
wind, and tide data. It is this output that is used as input to the SURF model. The ‘Surf 
Transect’ tab can only be accessed once the ‘Area Coordinates’ tab data has been 
entered correctly. 
 
 



 
DSTO-GD-0475 

 
23 

 
Figure 14: The ‘Surf Transect’ tab showing the approach to the beach as well as the depth profile 

along the surf transect. 

 
 
The only inputs required for the ‘Surf Transect’ tab are the two endpoint coordinates of 
the surf transect. The coordinates can be either entered manually or can be defined by 
clicking on the  icon and then drawing a line on the map.  
 
There are guidelines on how the surf transect should be drawn. The surf transect can 
be no longer than 3000 metres and must traverse both land and water. For the SURF 
program to give reliable results, the land elevation must be greater than the highest 
tidal value plus wave height. Another proviso in accordance with the SURF manual 
[Osieki et al. 2002a, 2002b] is that the surf transect must be drawn perpendicular to the 
beach. Furthermore, there must be enough points along the surf transect, both onshore 
and offshore, so that valid SURF runs can be performed. In particular, there must be an 
adequate number of points onshore to ensure that the topographic height of the surf 
transect depth profile takes into account the maximum water level impacting on the 
beach slope. There must also be an adequate number of points offshore to enable a 
sufficient amount of outputs to be displayed so that an accurate picture of the surf zone 
may be obtained. 
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The GUI attempts to capture many of the errors associated with drawing the surf 
transect such as exceeding the maximum length of the surf transect and ensuring that it 
includes both land and water. However, not all errors are easy to trap. In particular, 
errors related to travelling over islands, or raised structures on the sea floor, may not 
be detected. For this reason, after the SWANSURF program has made all its checks, a 
graph of the depth profile is evoked to give the user a visualisation and, in turn, a 
better understanding of the sea floor terrain along the surf transect. The graph enables 
the user to view the structure of the sea floor to ascertain whether there exist any 
obstacles that would affect any surf operations. The onus is on the user to ensure that 
the surf transect is chosen appropriately. 
 
The number of data points along which SURF will produce output is determined 
automatically by the GUI and depends on the length of the surf transect. The shorter 
the surf transect, the closer the output points will be.  
 
Once the data has been entered correctly (that is, all ‘lights’ in the ‘Input Checklist’ 
frame are green and a project name and location have been chosen), press the ‘Create 
SWAN Input Files’ button. This will create the SWAN input files (see Figure 15 for the 
standard SWAN input file). Depending on the wave parameter type chosen, the GUI 
will produce either one or two input files. If ‘constant’ wave data is chosen, then only 
the standard input file will be created and SWANSURF will be run based on this input 
file. When any of the other wave options is chosen, a second input file called the ‘hot 
input file’ (*.inh) will also be created. This additional input file is used to drive the 
standalone SWAN program to create a ‘hotfile’. A ‘hotfile’ is a wave spectrum file that 
is created by the SWAN program run in stationary mode using multiwave initial 
conditions and only the first values for the wind and tide data. This ‘hotfile’ is used as 
input to a dynamic run of SWANSURF driven by the usual SWAN input file (*.inp) 
with the *.hot file as the initial wave field. 
 
Simply running the SWANSURF model in dynamic mode with the multiple wave data 
as an initial condition will cause errors in the first time step because the waves have not 
had time to fully propagate through the area of computation. Therefore, at the first 
time step, the initial condition would only be evident at the edges of the computational 
area; the internal part of the computational area would not show the correct wave 
characteristics. Using the ‘hotfile’ ensures that the waves have fully propagated 
through the area of computation and that the wave field has reached a steady state 
before the calculations begin for the first time step, thereby producing reliable results. 
  
Pressing the ‘Create SWAN Input Files’ button not only creates the required SWAN 
input files but also the files containing the input data in a form that meets SWAN 
model requirements. What files are created depends on the data input options selected 
by the user and includes the depth profile file (BathyTopo.bot), the wave spectrum file 
(WaveSpecFile.dat), the wind series file (WindSeries.dat), and the tide series file 
(TideSeries.dat). The depth profile file will always be created. The wind series and tide 
series files are created when the user chooses the time series option and provides 
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manual inputs for those particular parameters. Four wave spectrum files (one for each 
boundary of the computational area) are produced when the user chooses the multiple 
wave option in the ‘Wave Parameters’ tab. Once formed, these files are automatically 
saved to the chosen directory. Creating these files may take a few minutes, depending 
on the size of the SWAN input area and the number of additional files that must be 
produced. For a more detailed description of the form of the bottom, wind, tide, wave 
spectrum, and input files, refer to Appendix A:  File Formats.  
 
 

 
Figure 15: The SWAN input file produced by the GUI after the ‘Create SWAN Input Files’ 

button has been pressed. 

 
The GUI also allows the user to save input data by clicking on the save icon ( ) or by 
choosing File > Save Data. This data can then be reopened (click  or choose File > 
Open Data) to enable the user to easily make modifications to the inputs without 
having to re-enter all the data.  
 
This concludes the process of creating the SWAN input file using the GUI. The process 
described represents a significant simplification of the original SWAN input file setup 
process. (For more details of the SWAN input file and required inputs refer to [Booij 
2004]). As part of the simplification, a number of inputs relating to physical constraints 
and boundary conditions to the SWAN model have been preselected. For the technical 
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assumptions imposed by the GUI for constructing the SWAN input file refer to 
[Hamilton 2001].  
 
 
 
3.3 Running the SWANSURF Model 

Once the input file has been created, the coupled model can be run. It can either be run 
directly after the input file has been created, or it can be run at a later stage. To run the 
coupled model immediately, just reply ‘Yes’ to the message that appears after the input 
file is created (Figure 16). To run the SWANSURF model at a later stage or using an 
input file created in a previous SWANSURF session, choose ‘Run the SWANSURF 
Model’ from the ‘Options’ menu or simply click on the  icon. Click File > Open (or 

) to select the required project and then select Run Model > Start (or ). 
 

 
Figure 16: Message box appearing allowing the user to run SWANSURF straight after the 

input file has been created. 

 
The time taken for the model to run is dependent on the size of the computational area, 
the input parameters (for example, whether single or multiple wave data is used), and 
the number of time steps. As the program runs, SWAN run-time output is written to 
the ‘Print’ file and screen output for both models is written to the ‘screen’ file.  
 
After the coupled model is run, all outputs are stored in the project directory; that is, 
the directory where the SWAN input file was saved. 
 
 
3.4 Model Outputs 

The original GUI, which was developed to create the SWAN input file, was extended to 
allow the user to view the outputs produced by both the SWAN and SURF models. The 
raw data output files can be displayed (see Section 3.4.1 Viewing Reports). The GUI 
also converts these raw outputs into visual forms. In particular, the SWAN output can 
be viewed through the GUI as a map layer (see Section 3.4.3 Viewing Map Outputs) 
while the SURF output has been put into graphical format (see Section 3.4.2 Viewing 
Graphical Output) and in the form of a ‘traffic light’ system linked to various landing 
craft (see Section 3.4.4 Viewing ‘Traffic Light’ Output). 
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3.4.1 Viewing Reports 

The GUI enables the user to view the output reports and the input files, by choosing 
Options > View Files (Input, Data, and Output) from the menu (or using the  icon). 
Use the ‘Open’ icon ( ) to select the required file. 
 
The SWAN output reports that can be viewed are the output tables, *_SWAN1D.tab 
and *_SWAN2D.tab, and the wave spectrum file, *_SWANSpec.out, where ‘*’ 
represents the project name. The one-dimensional output table (*_SWAN1D.tab) 
contains data along the surf transect, while the two-dimensional output table 
(*_SWAN2D.tab) contains interpolated data for the entire computational area. Data 
elements contained in the tables consist of latitude and longitude coordinates (in 
degrees), x and y wind components (metres per second), depth (metres), significant 
wave height (metres), wave direction (degrees, clockwise from true North), and period 
(in seconds) for each computational time step. The one-dimensional table also includes 
distance offshore (in metres).  
 
It should be noted that the SWAN depth output includes the bottom (datum) level plus 
water level (tides) but does not include wave-induced set-up on the shoreline (that is, 
the elevation in the mean water level as a result of wave breaking). This is due to the 
fact that set-up is not computed correctly by the SWAN program when spherical 
coordinates are used ([Booij et al. 2004] p70). 
 
The SURF output consists of a detailed surf output report (*.out). The original SURF 
program outputs results in feet and knots. SWANSURF converts these results to metres 
and metres / second to make the SURF program compatible with SWAN. Therefore, 
the SURF output file shows SURF outputs converted to metres and metres per second. 
Furthermore, the results of this report have been summarised by the SWANSURF 
model in a plot data file (*.pdt). This file can be viewed through the GUI and is also 
used by the GUI to graph the SURF findings.  
 
3.4.2 Viewing Graphical Output 

The SWANSURF GUI was set up to plot the output generated by SURF, as summarised 
in the plot data file, *.pdt, where ‘*’ is the project name. To access the graphical output 
viewer, choose Options > View Visual Output > Graphs or click on the  icon. Then 
press File > Open ( ) and choose the graph data file (*.pdt) required. The types of 
graphs that can be displayed are to be found in the ‘View Graphs’ menu. The graphs 
available are breaker angle, breaker height, breaker type, depth profile (that is, bottom 
depth plus tides), longshore current, Modified Surf Index, significant wave height, 
number of surf lines, surf zone width, and wind.  
 
The following figures (Figure 17 (a)–(i)) show the graphical output obtained from a 
SWANSURF run. The data for these charts is obtained from the SURF model output.    
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(a) Breaker Angle (b) Breaker Height 
  

  
(c) Breaker Type (d) Depth Profile 
  

  
(e) Longshore Current (f) Modified Surf Index 
  



 
DSTO-GD-0475 

 
29 

  
(g) Significant Wave Height (h) Number of Surf Lines 
  

  
(i) Surf Zone Width (j) Wind 

Figure 17: SURF output graphs. 

 
 
3.4.3 Viewing Map Outputs 

The GUI allows the SWAN tabular outputs to be displayed on a map in graphical form. 
This makes it easier for the user to visualise the bathymetry/topography and wave and 
wind conditions in the area of interest.  
 
To view outputs on a map of the computational area, first click Options > View Visual 
Output > Contour Plots or alternatively, click on the  icon. This will bring up a 
world map. Choose Map Tools > Add Map Layer from the menu or click on  to add 
a chart to the map (for example, a SeaFarer chart). Alternatively, click on Map Tools > 
Click a SeaFarer Tile to Load Chart Image (  icon) and then click on the predefined 
square to load a preloaded SeaFarer GeoTiff. The user is then able to add SWAN 
outputs on top of this map layer. To do this, choose Map Tools > Create a Map Layer 
from a SWAN Output Table or simply click . This will display an ‘Open’ dialogue 
box. Select the *.tab file for the project required. This will reveal a ‘Choose Parameter’ 
dialogue box from which the required parameter – namely, depth, wave height, wave 
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direction, wave period, wind speed or wind direction – and time step can be selected 
(Figure 18). Once ‘OK’ is pressed, an ESRI shapefile is created. To display this shape 
file on the map, select Map Tools > Add SWAN Map Layer or click  to select the 
required shape file (.sws). 
 
 

 
Figure 18: The ‘Choose Parameters’ dialogue box. 

 
Figure 19 shows the map outputs for the example SWANSURF run. Figure 19 (a) 
represents the depth profile.  
 
Figure 19(b) represents the wave heights. The wave heights are characterised according 
to sea state as defined in the Admiralty Manual of Navigation: Volume 2 [Great Britain. 
Royal Navy, 1960] (see Appendix D:  Sea State Categories and the Beaufort Wind Scale 
for Contour Plot Output). Wave direction is depicted in Figure 19 (c) and is marked on 
the map with a ‘V’. Therefore, ‘V’ on the map would mean that the wave is coming 
from the North (0 degrees in Nautical convention). ‘<’ represents a wave coming from 
the East (90 degrees), ‘^’ is a wave coming from the South (180 degrees), and ‘>’ is a 
wave coming from the West (270 degrees). The map also includes any wave direction 
between these four cardinal points. A ‘.’ denotes a land value. (Note that the land 
values as represented by the SWAN output and the land values as represented by the 
GeoTiff do not always align due to the coarse bathymetry used.)  Figure 19 (d) 
represents the wave period, which is simply characterised by a uniform split between 
the highest and lowest period.  
 
Figure 19 (e) represents the wind speed, categorised by the Beaufort scale as described 
in the Admiralty Manual of Navigation: Volume 2 [Great Britain. Royal Navy, 1960] 
(see Appendix D:  Sea State Categories and the Beaufort Wind Scale for Contour Plot 
Output). Figure 19 (f) represents the wind direction. It is displayed in a similar fashion 
to the wave direction. 
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(a) Depth (b) Wave Height 
  

  
(c) Wave Direction (d) Wave Period 
  

  
(e) Wind Speed (f) Wind Direction 

Figure 19: SWAN map outputs. 

 
Note that older versions of SWAN could produce graphical map outputs in HPGL 
format. These are not produced by the later version of SWAN (40.41) that forms part of 
the coupled model.  
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3.4.4 Viewing ‘Traffic Light’ Output 

The GUI is able to create ‘Traffic Light’ output from the Modified Surf Index (MSI) 
value calculated by the SURF program. The MSI is a single dimensionless number that 
provides a summary of the surf conditions at a given time. A higher number means 
rougher conditions. Therefore, this index is a good indicator for the feasibility of 
performing landing operations with different types of landing craft. The safety of 
utilising a particular type of landing craft is dependent on the environmental 
conditions that can be effectively summarised using the MSI. Table 1 shows MSI cut off 
values for some classes of landing craft. These values are extracted from the US Joint 
Surf Manual [COMNAVSURFPAC/COMNAVSURFLANT 1987]. Note that some of the 
platforms listed are not part of the Royal Australian Navy fleet. This output should be 
updated to account for data pertaining to Australian amphibious platforms. 
 
Table 1: Modified Surf Index limits for the safe landing of various craft. 

Landing Craft SAFE CARE REQUIRED UNSAFE 
LCM8 MSI ≤ 7 7 < MSI ≤ 8  MSI > 8 
LARC V MSI ≤ 8 8 < MSI ≤ 9  MSI > 9 
LCU MSI ≤ 11 11 < MSI ≤ 12  MSI > 12 
Pontoon MSI ≤ 6 6< MSI ≤ 7  MSI > 7 
 
The purpose of the ‘traffic lights’ output in the GUI is to show the user which sorts of 
landing craft may be used safely at a particular landing site, at a particular time, for 
particular environmental conditions. To access the traffic light output, click Options > 
View Visual Output > Traffic Lights or press  and then open the required project. A 
coloured table is then displayed for each time step (the maximum is 26 time steps) and 
for various craft types (Figure 20). Green means safe, red is unsafe, while amber 
denotes that discretion is required. By referring to this output, the operator can tell at a 
glance the most appropriate landing craft for a given beach. 
 
Note that the MSI enables the operator to ascertain the most feasible craft given the 
surf conditions for a particular landing site. However, the MSI does not take into 
account the skill level of personnel or the condition of the landing craft. These factors 
must be taken into consideration, especially when the MSI falls in the amber zone. The 
MSI is a single number representing a range of complex sea state conditions, and is a 
guide only. 
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Figure 20: Traffic light outputs. 

 
 
 

4. Potential Future Modifications 

The SWAN program is continually updated by its authors at the Delft University of 
Technology to fix bugs discovered in the model and to improve the model physics. 
Therefore, the SWANSURF model can be kept current by upgrading the SWAN 
component of the model with the latest releases. This would require updating some of 
the SWANSURF model code. Although a newer version of SURF is available (SURF 
3.2), SURF is no longer being updated.  
 
A significant improvement to the current GUI would be an extension to allow the user 
to input wave data from larger-scale wave models, such as WAM.  
 
Like all models, the accuracy of the outputs depends on the accuracy of the inputs. The 
SURF model accuracy is particularly dependent on the accuracy of the inputted 
nearshore bathymetry and offshore wave conditions. Having accurate forecasts is 
important in an operational context. Accurate forecasts are not only essential to ensure 
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that landing craft and personnel are not put into jeopardy; if the MSI is forecast higher 
than it actually is, options such as choice of landing craft could be restricted needlessly.  
 
Mettlach and May [1997] studied the accuracy of SURF96 (an older version of SURF) 
with a particular emphasis on how the Modified Surf Index changed with respect to 
the input depth profile. By maintaining the accuracy of the wind, tides, and wave 
inputs, they were able to study the effects that different bathymetry profiles had on the 
model output. After analysing experimental results from 373 SURF runs, they 
concluded that the input bathymetry profile had a critical effect on the output 
produced. 
 
Mettlach and May [1997] found that the Modified Surf Index accuracy depended 
largely on the age of the bathymetric profile used and the profile slope. Outdated 
bathymetric data led to fractional root-mean-square errors ranging from 19 to 44 per 
cent, while errors in depth profile slope estimation led to fractional root-mean-square 
errors ranging from 0 to 25 per cent. They discovered that in order to obtain results 
containing less than ten per cent error, the inputted depth profile had to be less than a 
day old and that the estimated slope should have less than ten per cent error. Simple 
sediment type-based depth profiles led to errors of 28 per cent. It is for this reason that 
the coupled model constructs a depth input file from actual bathymetry data to run the 
SURF model, rather than just specifying the sediment type. 
 
Although Mettlach and May [1997] based their studies on a previous version of SURF, 
the importance of an accurate bottom profile is still current. Therefore, owing to the 
sensitivity of SURF to the bottom profile and the ever-changing nature of the sea floor 
due to wind and wave action, there is a need to constantly feed new bathymetry 
profiles into the SURF model to maintain accuracy. Consequently, it would be useful to 
incorporate a bottom sediment transportation model into the process for longer term 
forecasts. This would help provide more meaningful results. SWAN also needs 
accurate bathymetry to produce optimum results. 
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Appendix A:  File Formats 

A.1. Depth Data File (BathyTopo.bot) 

 
The depth file that is created by the GUI (BathyTopo.bot) conforms to the standard 
SWAN format. It contains two header lines of the form: 
 

BOTTOM REGULAR [xpinp] [ypinp] [alpinp] [mxinp] [myinp] [dxinp] [dyinp] 
BOTTOM [factor] ‘filename’ 2 2 FORMAT ‘(F6.0)’  

 
where xpinp and ypinp are the longitude and latitude of the lower left corner of the 
SWAN bottom input grid, alpinp is the direction of the x- axis of the bottom input grid 
(for the purpose of the GUI, this is always zero), mxinp and myinp are the number of 
meshes in the x and y directions (which is one less than the number of grid points in 
that direction), and dxinp and dyinp are the mesh sizes in the x and y directions of the 
bottom input grid. All data values are multiplied by ‘factor’. In this file, consistent with 
both SWAN and SURF convention, depths are positive values while land elevations are 
negative. If the data had positive elevations and negative depths, then the factor would 
be ‘–1’. The first ‘2’ in the second header line defines the way in which the data in the 
file is read. For this case, it indicates that the bottom values are input and read starting 
from the upper-left corner of the input grid and reading from left to right. The second 
‘2’ simply states that there are two header lines in the bottom file. ‘(F6.0)’ is a Fortran 
format describing the structure of the data points. Following the two header lines is a 
single column of bathymetric and topographic data. SWANSURF records the data 
values in this column starting from the top left corner of the area under investigation 
reading the map from left to right. For more information regarding the bottom file 
format refer to the SWAN Manual ([Booij, 2004] pp 51 – 56).  
 
 
A.2. Wind (WindSeries.dat) and Tide (TideSeries.dat) Files 

The wind and tide files (WindSeries.dat and TideSeries.dat, respectively) are created 
when the user chooses the time series option for that particular parameter where data 
for each time step has been manually inputted. Their form mirrors that of the depth 
data file. There are two header lines in the file of the form: 
 

INPGRID Parameter REGULAR [xpinp] [ypinp] [alpinp] [mxinp] [myinp] [dxinp] 
[dyinp] NONSTAT [tbeginp] [deltinp] unit [tendinp] 
READINP Parameter [factor] ‘filename’ 2 2 FORMAT ‘(F6.0)’  

 
Parameter is either WIND or WLEVEL depending on whether the data contained in the 
file refers to the wind or tide level. [tbeginp] is the start time of the data contained in 
the file while [tendinp] is the end time. Both start and end times are in the form 
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YYYYMMMDD.HHmmSS where YYYY is the year, MM is the month, DD is the day, 
HH is the hour, mm is the minutes, and SS is the seconds. The year is a four digit 
number. All other components of the date are two digit numbers. [deltinp] is the time 
interval of the data and unit is the unit with which this time interval is measured - 
either SEC for seconds, MIN for minutes, HR for hours, or DAY for days. 
 
A single column of data for the chosen SWAN area, which is read from left to right 
starting at the top left corner, follows. Since this is a time series file, subsequent time 
step data is appended to the same file in the same format. It should be noted that the 
wind input that is written into the WindSeries.dat file is broken up into its x and y 
components with the x components written first for one time step, followed by the y 
component for that time step. Subsequent time step data is appended to the file 
following the same layout. 
 
If the user elects to use the ‘Data from a File’ option in the ‘Wind’ or ‘Tides’ tab, then 
the file used must have this standard SWAN format.  
 
 
A.3. Wave Spectrum File (WaveSpecFile.dat) 

Figure 21 is an example of the wave spectrum file (WaveSpecFile.dat) in the required 
SWAN format. A brief description of the two-dimensional spectrum file follows. 
 

‘SWAN’ Version number  
‘LONLAT’ [for spherical coordinates] OR ‘LOCATIONS’ [for Cartesian 
coordinates] 
Number of locations 
Location coordinates 
 
‘AFREQ’ [for absolute frequency] OR ‘RFREQ’ [for relative frequency] 
Number of frequencies  
Single column of frequencies in Hz 
 
’CDIR’ 
Number of directions 
Single column of directions in degrees 
 
‘QUANT’ 
Number of quantities 
For each quantity:  Name 
    Units 
    Exception Value 
 
‘FACTOR’ OR ‘ZERO’ [if the spectrum is 0] OR ‘NODATA’ [if the spectrum cannot 
be computed (for instance, the spectrum would not be computed on land)]  
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 The factor by which to multiply all values in the ensuing density table. 
 Scaled energy / variance densities. 
 
If the user elects to use the ‘Data from a File’ option in the ‘Wave Parameters’ tab then 
the file must be in the spectrum file form described. For more information regarding 
the form of the SWAN wave spectrum file refer to the SWAN Manual ([Booij, 2004] pp 
100-105). 
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SWAN   1 
LONLAT 
     1 
        1.00        1.00 
AFREQ 
    32 
  0.04000 
  0.04438 
  0.04923 
  0.05462 
  0.06060 
  0.06723 
  0.07458 
  0.08274 
  0.09179 
  0.10184 
  0.11298 
  0.12534 
  0.13906 
  0.15427 
  0.17115 
  0.18988 
  0.21066 
  0.23371 
  0.25928 
  0.28765 
  0.31912 
  0.35404 
  0.39278 
  0.43575 
  0.48343 
  0.53633 
  0.59501 
  0.66012 
  0.73235 
  0.81248 
  0.90138 
  1.00000 
CDIR 
    36 
   5.0 
  15.0 
  25.0 
  35.0 
  45.0 
  55.0 
  65.0 
  75.0 
  85.0 
  95.0 
 105.0 
 115.0 
 125.0 
 135.0 
 145.0 
 155.0 
 165.0 
 175.0 
 185.0 
 195.0 
 205.0 
 215.0 
 225.0 
 235.0 
 245.0 
 255.0 
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 265.0 
 275.0 
 285.0 
 295.0 
 305.0 
 315.0 
 325.0 
 335.0 
 345.0 
 355.0 
QUANT 
    1 
VaDens 
m2/Hz/degr 
   -1.0 
FACTOR 
        9.4074869E-07 
    53   283   372   123     9     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     2 
   542  2871  3775  1254    98     1     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     0    22 
  2097 11103 14600  4851   379     5     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     0    88 
  4293 22729 29887  9931   824   410  1000   796   197    14     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     0     0     1   180 
  5775 30572 40199 13365  1328  2395  5971  4751  1180    83     1     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     0     0     0     1   242 
  5887 31165 40979 13640  1856  6665 16692 13280  3300   233     3     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     0     0     0     1   247 
  4997 26457 34789 11615  2745 15482 38829 30892  7678   544     9     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0   
0     0     0     0     0     0     0     1   210 
  3760 19904 26173  8841  5422 39845 99998 79556 19773  1401    23     0     0     0     0     0     0     0     0     1     3     3     1     0     0     0     0   
0     0     0     0     0     0     0     1   158 
  2612 13827 18182  6118  2987 21131 53027 42187 10485   743    12     0     0     0     0     0     0     0     4    23    54    54    23     4     0     0   
0     0     0     0     0     0     0     0     0   109 
  1721  9113 11983  4015  1433  9428 23655 18819  4677   331     5     0     0     0     0     0     0     1    22   128   297   297   128    22     1     0   
0     0     0     0     0     0     0     0     0    72 
  1095  5800  7627  2557   961  6412 16089 12800  3181   225     3     0     0     0     0     0     0     3    61   342   789   789   342    61     3     0   
0     0     0     0     0     0     0     0     0    46 
   681  3608  4745  1592   637  4325 10852  8633  2145   152     2     0     0     0     0     0     0    10   150   829  1902  1897   821   146     9     0   
0     0     0     0     0     0     0     0     0    28 
   417  2211  2907   976   408  2796  7016  5582  1387    98     1     0     0     0     0     0     1    36   402  2039  4537  4471  1925   341    22     0   
0     0     0     0     0     0     0     0     0    17 
   253  1341  1764   592   255  1757  4410  3508   872    61     1     0     0     0     0     0     6    78   461  1523  2708  2391   974   167    10     0   
0     0     0     0     0     0     0     0     0    10 
   152   808  1063   357   156  1084  2721  2164   538    38     0     0     0     0     0     0    15   173   824  1968  2528  1738   598    92     5     0   
0     0     0     0     0     0     0     0     0     6 
    91   485   637   214    95   660  1658  1319   327    23     0     0     0     0     0     1    40   429  1941  4179  4564  2568   720    92     4     0     0   
0     0     0     0     0     0     0     0     3 
    54   290   381   128    57   399  1002   797   198    14     0     0     0     0     0     2    78   831  3709  7755  8013  4130  1026   113     4     0   
0     0     0     0     0     0     0     0     0     2 
    32   173   227    76    34   240   602   479   119     8     0     0     0     0     0     1    32   351  1572  3315  3481  1843   477    55     2     0     0   
0     0     0     0     0     0     0     0     1 
    19   103   135    45    20   143   361   287    71     5     0     0     0     0     0     0    16   180   811  1719  1824   981   259    31     1     0     0     0   
0     0     0     0     0     0     0     0 
    11    61    81    27    12    86   215   171    42     3     0     0     0     0     0     0    11   124   559  1181  1246   664   173    20     0     0     0     0   
0     0     0     0     0     0     0     0 
     6    36    48    16     7    51   128   102    25     1     0     0     0     0     0     0     7    83   372   785   824   436   112    13     0     0     0     0     0   
0     0     0     0     0     0     0 
     4    21    28     9     4    30    76    61    15     1     0     0     0     0     0     0     5    53   238   502   526   277    71     8     0     0     0     0     0     0   
0     0     0     0     0     0 
     2    13    17     5     2    18    45    36     9     0     0     0     0     0     0     0     3    33   149   313   328   172    44     5     0     0     0     0     0     0   
0     0     0     0     0     0 
     1     7    10     3     1    10    27    21     5     0     0     0     0     0     0     0     1    20    91   192   201   105    26     3     0     0     0     0     0     0   
0     0     0     0     0     0 
     0     4     6     2     0     6    16    12     3     0     0     0     0     0     0     0     1    12    55   117   122    64    16     1     0     0     0     0     0     0   
0     0     0     0     0     0 
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     0     2     3     1     0     3     9     7     1     0     0     0     0     0     0     0     0     7    33    70    73    38     9     1     0     0     0     0     0     0     0   
0     0     0     0     0 
     0     1     2     0     0     2     5     4     1     0     0     0     0     0     0     0     0     4    20    42    44    23     5     0     0     0     0     0     0     0     0   
0     0     0     0     0 
     0     0     1     0     0     1     3     2     0     0     0     0     0     0     0     0     0     2    12    25    26    13     3     0     0     0     0     0     0     0     0   
0     0     0     0     0 
     0     0     0     0     0     0     2     1     0     0     0     0     0     0     0     0     0     1     7    15    15     8     2     0     0     0     0     0     0     0     0     0   
0     0     0     0 
     0     0     0     0     0     0     1     0     0     0     0     0     0     0     0     0     0     0     4     9     9     4     1     0     0     0     0     0     0     0     0     0   
0     0     0     0 
     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     2     5     5     2     0     0     0     0     0     0     0     0     0     0   
0     0     0     0 
     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     0     1     3     3     1     0     0     0     0     0     0     0     0     0     0   
0     0     0     0 

Figure 21: An example of the SWAN spectrum file. 

 
 
 
A.4. SWAN Input Files 

Figure 22 and Figure 23 show the form of the two SWAN input files that are created by 
the SWANSURF GUI. Whenever the multiple data option for waves is used, the 
SWANSURF model sets up two input files. One is the ‘hot’ input file (Figure 22), *.inh, 
which is used to run the standalone SWAN model in stationary mode to produce the 
‘hotfile’. The second input file is the standard SWAN input file, *.inp, which is used to 
run the SWANSURF model (Figure 23) in dynamic (nonstationary) mode with the 
‘hotfile’ as the initial condition for the wave input field. 
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PROJ 'Example' '1' 'INPUT TO SWAN WAVE MODEL' 
MODE STATIONARY TWODIMENSIONAL 
COORD SPHE QC 
CGRID REGULAR 151.2188889 -34.0316667 0 0.0266667 0.0130556 19 14 CIRCLE 36 0.04 1 31 
SET NAUTICAL 
INPGRID BOTTOM REGULAR 151.1888889 -34.0616667 0 9 7 0.01 0.01 
READINP BOTTOM 1 'C:\SWANSURF_Proj\BathyTopo.bot' 2 2 FORMAT '(F6.0)' 
BOUNDSPEC SIDE NORTH CONSTANT FILE 'C:\SWANSURF_Proj\WaveSpecFileN.dat' 
BOUNDSPEC SIDE EAST CONSTANT FILE 'C:\SWANSURF_Proj\WaveSpecFileE.dat' 
BOUNDSPEC SIDE SOUTH CONSTANT FILE 'C:\SWANSURF_Proj\WaveSpecFileS.dat' 
BOUNDSPEC SIDE WEST CONSTANT FILE 'C:\SWANSURF_Proj\WaveSpecFileW.dat' 
WIND 9.4 170 
SET LEVEL 0.1 
FRICTION JONSWAP 0.067 
QUAD 
SET MAXERR 2 
$ 
PROP BSBT 
NUMERIC ACCUR NONST 30 DIRIMPL 0.5 4 
$ 
TABLE 'COMPGRID' HEAD 'Example_HOTSWAN2D.tab' XP YP WIND DEP HSIGN DIR 
TM01 
$ 
TEST 0,0 
COMPUTE 
$ 
HOTF 'Example.hot' 
$ 
STOP 
$ 

Figure 22: The hot input file (*.inh) generated by the SWANSURF GUI. This input file is used 
to create the wave spectrum hotfile. The hotfile will, in turn, provide the initial wave 
field to run the SWANSURF model. 
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PROJ 'Example' '1' 'INPUT TO SWAN WAVE MODEL' 
MODE DYNAMIC TWODIMENSIONAL 
COORD SPHE QC 
CGRID REGULAR 151.2188889 -34.0316667 0 0.0266667 0.0130556 19 14 CIRCLE 36 0.04 1 31 
SET NAUTICAL 
INPGRID BOTTOM REGULAR 151.1888889 -34.0616667 0 9 7 0.01 0.01 
READINP BOTTOM 1 'C:\SWANSURF_Proj\BathyTopo.bot' 2 2 FORMAT '(F6.0)' 
INIT HOTS 'Example.hot' 
$ 
INPGRID WIND REGULAR 151.2188889 -34.0316667 0 19 14 0.0014035 0.0009325 NONSTAT 
20050819.040000 3 HR 20050820.130000 
READINP WIND 1 'C:\SWANSURF_Proj\WindSeries.dat' 2 2 FORMAT '(F6.1)' 
INPGRID WLEVEL REGULAR 151.218889 -34.031667 0 19 14 0.001404 0.000933 NONSTAT 
20050818.040000 6 HR 20050820.220000 
READINP WLEVEL 1 'C:\SWANSURF_Proj\TideSeries.dat' 2 2 FORMAT '(F6.1)' 
FRICTION JONSWAP 0.067 
QUAD 
SET MAXERR 2 
$ 
PROP BSBT 
NUMERIC ACCUR NONST 30 DIRIMPL 0.5 4 
$ 
TABLE 'COMPGRID' HEAD 'Example_SWAN2D.tab' XP YP WIND DEP HSIGN DIR TM01 
OUTPUT 20050819.040000 3 HR  
CURVE 'Transect ' 151.22 -34.0247222 735 151.2430556 -34.0194444 
TABLE 'Transect ' HEAD 'Example_SWAN1D.tab' XP YP WIND DEP HSIGN DIR TM01 DIST 
OUTPUT 20050819.040000 3 HR  
SPECOUT 'Transect ' SPEC2D ABS 'Example_SWANSpec.out'  OUTPUT 20050819.040000 3 HR  
$ 
TEST 0,0 
COMPUTE NONSTAT 20050819.040000 3 HR 20050820.130000 
STOP 
$ 

Figure 23: The SWAN input file (*.inp) created by the GUI to run the multi-step SWANSURF 
model. 
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Appendix B:  SWANSURF Model Installation 

All files required to operate SWANSURF are included in the setup package and are 
placed in the required directories when the setup wizard is activated. The SWANSURF 
executable program, SWANSURF.exe, will be placed in the directory C:\Program 
Files\SWANSURF. To run the program, simply open the SWANSURF.exe file. 
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Appendix C:  SWANSURF GUI Toolbar Buttons 

 
C.1. GUI Start Up 

Table 2: The SWANSURF GUI start up toolbar. 

Toolbar Button Purpose 
  

 
Create a new SWAN input file or view an existing SWAN input file. 

    

 
Run SWANSURF. 

    

 
View the output reports produced by the SWAN and SURF models. 

    

 
View output graphs produced from SURF output data. 

    

 
View contour plots on a map. 

    

 
View ‘traffic lights’ graphical table created from  SURF output. 

   
 
 
C.2. Create SWAN Input File 

Table 3: The ‘Create SWAN Input File’ toolbar. 

Toolbar Button Purpose 
  

 
Create a new SWAN input file. 

    

 
Open and view an existing SWAN input file.  

    

 
Delete SWAN data from input text boxes. 

    

 
Save data. 
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Print. 

    

 
Zoom in. 

    

 
Zoom out. 

    

 
Pan. 

    

 
Select the SWAN computational area. 

    

 
Draw the surf transect on the map. 

    

 
Click on a predefined box on the map to load a SeaFarer tile. 

    

 
Add a map layer (either a GeoTiff or a shapefile). 

   
 
C.3. Run SWANSURF 

Table 4: The ‘Run SWANSURF’ toolbar. 

Toolbar 
Button 

Purpose 

  

 
Open the SWAN input file (*.inp) associated with the project that is to 
be run. 

    

 
Run the SWANSURF model. 

   



 
DSTO-GD-0475 

 
49 

 
C.4. View Output Reports 

Table 5: The ‘View Output Reports’ toolbar. 

Toolbar 
Button 

Purpose 

  

 
Open the SWAN and SURF output files (*.out, *.tab, *.pdt) of the 
desired project. 

   
 
C.5. View Graphs 

Table 6: The ‘View Graphs’ toolbar. 

Toolbar 
Button 

Purpose 

  

 
Open the SWAN and SURF graph data output file (*.pdt) of the 
desired project. 

    

 
Print graph. 

   
 
C.6. View Contour Plots 

Table 7: The ‘Contour Plots’ toolbar. 

Toolbar Button Purpose 
  

 
Open required project. 

    

 
Save current contour plot display. 

    

 
Print the map area. 

    

 
Zoom in. 

    

 
Zoom out. 

    

 
Pan. 
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Click on a predefined box on the map to load a SeaFarer tile. 

    

 
Add a map layer (either a GeoTiff or a shapefile). 

    

 
Remove a map layer from the map. 

    

 
Create a map layer from a SWAN output table. 

    

 
Add SWAN Map Layer. 

   
 
 
C.7. View Traffic Lights 

Table 8: Traffic Lights form toolbar buttons. 

Toolbar 
Button 

Purpose 

  

 
Open the SWAN and SURF graph data output file (*.pdt) of the 
desired project. 
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Appendix D:  Sea State Categories and the Beaufort 
Wind Scale for Contour Plot Output 

 
D.1. Sea State Categories 

The contour plot output of the wave heights is categorised according to sea state as 
follows (reproduced from [Great Britain. Royal Navy, 1960]): 
 
Table 9: Sea state categories according to wave height. (Reproduced from [Great Britain. Royal 

Navy, 1960]) 

Number Height 
(metres) 

Description Effect 

0 0 Calm (glassy) No wave breaking on beach. 
1 0 – 0.1 Calm (rippled) No wave breaking on beach. 
2 0.1 – 0.5 Smooth Slight wave breaking on beach. 
3 0.2 – 1.25 Slight Wave rocks buoys and small craft. 
4 1.25 – 2.5 Moderate Sea becoming furrowed. 
5 2.5 – 4 Rough Sea deeply furrowed. 
6 4 – 6 Very rough Sea much disturbed with rollers 

having steep fronts. 
7 6 – 9 High Sea much disturbed with rollers 

having steep fronts (damage to 
foreshore). 

8 9 – 14 Very high Towering seas. 
9 Over 14 Phenomenal Precipitous seas (experienced only 

in hurricanes). 
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D.2. Beaufort Wind Scale 

 
The contour plot output of the wind speed is categorised according to the Beaufort 
wind scale [Great Britain. Royal Navy, 1960]: 
 
 
Table 10 Beaufort wind scale. (Reproduced from [Great Britain. Royal Navy, 1960]) 

Wind Force 
(Beaufort) 

Speed  
(knots) 

Speed  
(metres/second) * 

Description 

1 < 1 < 0.51 Calm 
2 1-3 0.51 - 2.06 Light air 
3 4-6 2.06 - 3.60 Light breeze 
4 7-10 3.60 - 5.66 Gentle breeze 
5 11-16 5.66 - 8.74 Moderate breeze 
6 17-21 8.74 - 11.32 Fresh breeze 
7 22-27 11.32 - 14.40 Strong breeze 
8 28-33 14.40 - 17.49 Near gale 
9 34-40 17.49 - 21.09 Gale 

10 41-47 21.09 - 24.69 Strong gale 
11 48-55 24.69 - 28.81 Storm 
12 56-65 28.81 - 33.95 Violent storm 

  13 ** 66-71 33.95 - 37.04 Hurricane 
14 72-80 37.04 - 41.67 - 
15 81-89 41.67 - 46.30 - 
16 90-99 46.30 - 51.44 - 
17 100-108 51.44 - 55.56 - 

 
 
 
 

                                                      
* This column is not reproduced from [Great Britain. Royal Navy, 1960]. The conversions were 
made by multiplying the speed in knots by 0.5144. 
** In the GUI, the ‘Contours’ form combines categories 13, 14, 15, 16, and 17 for display 
purposes. 
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